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COPYRIGHT AND TRADEMARKS 

Double Image® is a registered trademarks of Host Interface International, Incorporated. 

Microsoft Windows®, Windows Backup And Restore®
 and Microsoft Windows Installer® are registered 

trademarks of Microsoft Corporation. 

InstallShield® is a registered trademark of InstallShield Corporation. 

Veritas Volume Manager™ with all rights now with Symantec. 

Netware, HP, Samba, Veritas, Amiga, Beeweeb, Buffalo, UNIX, Linux, (including Novel's SUSE Linux) and other 

brands and their products are trademarks or registered trademarks of their respective holders and should be 

noted as such. 

 

LIMITATION OF LIABILITY 

Double Image Systems or its authors of this draft document shall in no event be liable for any direct, indirect, 

incidental, consequential, or exemplary damages for application and use of content, herein. This document 

includes hyperlinks to third-party content and websites. You agree that Double Image Systems is not 

responsible for by application of any content herein, or references to other products or resources available 

from such resources or websites.  
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COMPARISON: ‘WINDOWS BACKUP AND RESTORE’ AND DOUBLE IMAGE 7.0 

 

Topic or Feature Double Image 7.0’ Windows Backup and Restore 

Operating Systems 

Windows Server 2016 

Windows 10 

Windows Server 2012 

Windows 8.1 

Windows Server 2008 R2 

Windows Server 2008  

Windows 7 

Windows Vista   

Windows Server 2003   

Windows XP  

Windows Server 2008 R2 

Windows Server 2008 

Windows 7 

Windows Vista 

 

Backup and Restore is deprecated in 

Windows 8. Microsoft says this 

program is underused and is touting 

File History as the feature that replaced 

file-based backup. 

 

See "Windows and Windows Server 

Developer Preview Compatibility 

Cookbook" 

Backup Storage 

Any Windows controlled drive that has a 

Windows NTFS file system. 

And any Windows controlled local or 

external drive with these file systems. 

And any drive located on a local network 

or domain network with any of these 

extended file systems, including those 

supported under a variety of Linux 

systems. 

Any Windows controlled drive that has 

a Windows NTFS file system. 

Backup Server Storage 

 Windows  

 Windows Server  

 Windows Virtual  

 VMware  

 Linux  

 IBM Domino  

 Blackberry Server 

 Windows  

 Windows Server 

http://en.wikipedia.org/wiki/Features_new_to_Windows_8#File_History
http://www.microsoft.com/download/en/details.aspx?id=27416
http://www.microsoft.com/download/en/details.aspx?id=27416
http://www.microsoft.com/download/en/details.aspx?id=27416
https://hostinterface.com/WebHelp/File_Systems.htm
https://hostinterface.com/WebHelp/File_Systems.htm
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Backup to network Local or Domain 

Windows Vista has a limitation where 

only Home Premium, Business, 

Enterprise or Ultimate editions can 

schedule automatic backups or back 

up files and folders to a network 

location.  Full system backup to a 

network requires Windows 7 

Professional or above editions. 

Network Storage' Support 

 Buffalo  

 D-Link  

 Dell  

 Hitachi  

 HP  

 IBM  

 Intel  

 Iomega  

 LaCie  

 Linksys  

 NETGEAR  

 Seagate  

 Synology  

 Western Digital  

 ..and others 

 Windows NTFS file system, 

including USB and DVD. 

 

see limitations 

 

Network Shares  Any 

For Windows 7, file backup to a 

network share is available only with 

Windows 7 Professional, Enterprise and 

Ultimate editions. 
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File Systems Supported 

 NTFS  

 FAT32  

 FAT16  

 FAT12  

 exFAT  

 UDF  

 CDFS 

 Windows NTFS 

 

 

File Systems Recognized 

 ADFS  

 AFFS  

 AFS  

 BeeWeeb  

 BeFS  

 BFS  

 BSD  

 CDUDFRW  

 Coherent  

 DTFS  

 EAFS  

 EFS  

 EXT2  

 EXT3  

 FFS  

 FreeBSD  

 FSUDF  

 GPFS  

 GroupDrive  

 HFS  

 HTFS  

 InCDFS  

 JFS  

 OpenBSD  

 OSpecial  

 Other  

 QNX  

 REISERFS  

 REISERFS3  

 REISERFS4  

 REVUDF  

 RFSD  

 RomFS  

 S5  

 S51K  

 Samba  

 SFS  

 Spiralog  

 SystemV  

 Text  

 UDF150  

 UDF200  

 UDFFS  

 UDFRDR  

 UDFS  

 UFS  

  

 NTFS (Full or incremental) 

 VHD (virtual hard disk for 

images) 

 CD and DVD formats selected 

by Windows Backup and 

Restore 
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 LFS  

 MaxFS  

 MFS  

 Minix  

 NetBSD  

 NetWare    

 NSS  

 NTFS (Unix, 

Linux)  

 NWFS286  

 NWFS386  

 ODS 

 USIUDF  

 V7  

 Version7  

 VPCType  

 VxFS  

 VxTools  

 WebDrive  

 XenixFS  

 XFS  

 XiaFS 

Backup, Restore sub-folders 

or files Yes 
 No, unless referencing a UNC 

path with a folder  

Backup types 

 File Backup. Files are written in 

Windows non-proprietary 

format, exactly as the Source. 

 File Backup. Files are saved to 

Zip files. 

 System Image. Files are saved 

block-by-block in a VHD file 

format, also allowing for 

subsequent Incremental 

backups. A VHD image can 

also be mounted for extracting 

individual files, or booted from 

(using Windows 7 Enterprise and 

Ultimate only) after the full 

system image backup has 

been done. 

http://en.wikipedia.org/wiki/VHD_%28file_format%29
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Schedule 

 Double Image provides its own 

easy scheduler interface to stage 

scheduled backup or restore 

tasks. 

 

The Double Image interface in-

turn references the options in the 

Windows Task Scheduler for 

actually running the tasks; much 

like any other task that is 

scheduled to run using the 

Windows Task Scheduler. 

 Scheduler setup options are: 

Daily, Weekly or manual. 

DOUBLE IMAGE 7.0  OPTIONS 

see complete details at:  https://hostinterface.com/WebHelp/ 

Selecting files during a 

backup 

 In addition to drive, folder, file selection check/uncheck, files may also be 

selected by applying a date range that is relative to the backup files 

modification timestamp. 

 Files may also be selected or un-selected based on wild cards. 

Example: *.doc, *.tmp 

Copying Options 

 Never over-write newer files with older files 

 Never over-write read-only files 

 Never Copy Zero Byte Files 

 Verify files as they are copied 

 Reset read-only file attribute as files are copied 

Run Options 
 Start Minimized 

 Auto-Exit at End of Job 

Delete Options  

(Delete files on target not 

found on source) 

 Minor Delete - delete only files and folders on the target below the copied 

source folders. 

 Major Delete - delete all files and folders in the target folder to match the 

source files and folders. 

 Warn Before Major Delete 

 Delete Excluded - Also delete files on the target that are excluded from the 

copying on the source. 

https://hostinterface.com/WebHelp/Scheduling_A_Backup_or_Restore.htm
https://hostinterface.com/WebHelp/
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Registry Backup and Restore 

 Don't back up registry files: Registry files are not backed up. 

 Back up the registry files on a computer if that computer has its Windows 

system folder backed up: Registry files will be backed up only if the 

Windows System folder is backed up. 

 Always back up the registry files of any computer that has any other files 

checked for back up: Registry files are backed up always. 

Compression Options 

 (default) Copy compression attributes to target files: if the file is 

compressed on the Source, it is compressed on the target. If the file is 

uncompressed on the Source, it is uncompressed on the Target. 

 Compress target files as they are copied: Double Image compresses all 

target files during the copy process. 

 Decompress files as they are copied: Double Image decompresses files 

being written to the target during the copy process, if compressed. 

 Ignore compression differences between source and target files and 

folders: Ignore the compression attribute. If the file is compressed on the 

source and uncompressed on the target, Double Image does not 

decompress on the Target file. 

 

A warning appears if the Target's file system does not support compression 

and the compression option has been turned on. If you have the Warning 

Option set to "Don't Pause for Warnings and Errors", the warning is 

entered in the log, only. Normally this warning can be ignored. 

Encryption Options 

 (default) If target is Windows NTFS. 

Keep the target files encryption attributes equal to the source files 

encryption attributes if the target is Windows NTFS). If the file is encrypted 

on the source, it is encrypted on the target. If the file is decrypted on the 

source, it is decrypted on the target. 

 Encrypt target files as they are copied 

Double Image will encrypt all Windows NTFS target files during the copy 

process. A warning message is presented (unless turned off) to alert the 

user of this intended action. 

 Decrypt encrypted files as they are copied 

Double Image decrypts all encrypted target files during the copy process. 

 Do not encrypt or decrypt files regardless of encryption attributes. 

If the file is encrypted on the source and not encrypted on the target, 

Double Image makes no encryption changes to the target file. 
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Selecting Files By Date and 

Wild Cards 

 Date and Time:   If a file's timestamp falls into the range, then only those 

files will be copied and all others will be ignored.  

 Including and Excluding Files:  Use wild cards to include certain files in a 

backup or restore or exclude certain files from a backup or restore. 

Special copying based on 

File Attributes 

 Don't copy hidden files:  Do not include hidden files in the copy process. 

Files with the hidden attribute are not copied. If ‘Don't copy hidden files’ is 

not checked, then hidden files are copied. 

 Don't copy system files:  Do not include system files in the copy process. 

Files with the system attribute are not copied. If ‘Don't copy system files’ is 

not checked, then system files are copied 

 Copy offline files:  Select this option to have Double Image backup the 

Offline Files folder, containing a cache/database representing one or more 

folders and files. 

 Reset archive bit on copied source files:  Set this option to reset the archive 

bit on files copied, as defined in the Double Image source tree. Note that 

when 

Warnings and Errors 

Reporting 

 Ask what to do when any error or warning is encountered. 

 Ask what to do when an error is encountered. 

 Ignore warning & errors, but show special dialogs. 

 Don't pause for any warnings, errors, or special dialogs. 

Log Options 

 Log all events 

 Log summary events only 

 Clear log before copy 

Log View and Search 

 See each log line item or view each item in dialog detail. 

 Search for Information in the Log Window. 

 Select 'More' to create multiple 'Find' conditions in the log. 

 Log Find Event Type. 

 Change Colors of Log Entries. 

 Sort individual columns within the log. 

Simulation Backup 

 A log is produced showing the files selected for a backup or restore and 

compares the backup and restore files, without actually doing a backup or 

restore (meaning no writes occur). 

 Report all files or just those that show differences between source and 

target. 
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 Show report to HTML, Text or internal log. 

WINDOWS BACKUP AND RESTORE OPTIONS 

Windows 7, 8 :  https://support.microsoft.com/en-us/help/17127/windows-back-up-restore 

Windows 10  : https://support.microsoft.com/en-us/help/4027408/windows-10-backup-and-restore 

Backup Tools 

 File Backup - Windows Backup allows you to make copies of data files for 

all people that use the computer. You can let Windows choose what to 

back up or you can select the individual folders, libraries, and drives that 

you want to back up. By default, your backups are created on a regular 

schedule. You can change the schedule and you can manually create a 

backup at any time. Once you set up Windows Backup, Windows keeps 

track of the files and folders that are new or modified and adds them to 

your backup. To set up file backup, see Windows Backup and Restore 

Options. 

 Select a destination drive 

 Let Windows choose the files to backup (recommended) 

 Let the user choose the files to backup. 

 

‘Set up backup’ first needs to be Configured before performing backup via 

the Wizard.  Alternatively, to setup the backup on a new machine for the 

first time using command line: 

%SystemRoot%\System32\sdclt.exe /Configure 

 System image backup - Windows Backup provides you with the ability to 

create a system image, which is an exact image of a drive. A system image 

includes Windows and your system settings, programs, and files. You can 

use a system image to restore the contents of your computer if your hard 

drive or computer ever stops working. When you restore your computer 

from a system image, it is a complete restoration; you can't choose 

individual items to restore, and all of your current programs, system 

settings, and files are replaced. Although this type of backup includes your 

personal files, it’s recommended that you back up your programs and data 

files regularly so that you can restore individual files and folders as needed. 

 

Using scheduled Windows Backups you can choose whether you want to 

include a system image. This system image only includes the drives 

required for Windows to run. You can manually create a system image if 

you want to include additional data drives. 

https://support.microsoft.com/en-us/help/17127/windows-back-up-restore
https://support.microsoft.com/en-us/help/4027408/windows-10-backup-and-restore
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 Previous versions - Previous versions are copies of files and folders that 

Windows automatically saves as part of system protection. You can use 

previous versions to restore files or folders that you accidentally modified 

or deleted, or that were damaged. Depending on the type of file or folder, 

you can open, save to a different location, or restore a previous version. 

Previous versions can be helpful, but should not be considered a backup 

because the files get replaced by new versions and will not be available if 

the drive were to fail. 

 

 System Restore -  System Restore helps you restore your computer's 

system files to an earlier point in time. It's a way to undo system changes 

to your computer without affecting your personal files, such as e-mail, 

documents, or photos. System Restore uses a feature called system 

protection to regularly create and save restore points on your computer. 

These restore points contain information about registry settings and other 

system information that Windows uses. You can also create restore points 

manually. For more information about System Restore, see Microsoft: 

System Restore 

 

Full Backup and Incremental 

 An incremental backup adds to the backup file only those items that have 

changed since the last backup. After a default 50% of differences between 

source and destination, does a Full backup automatically re-occur; and in 

this case the older Full backup is re-written.  Technical side note. The user 

can add a registry and provide % value to override ‘Backup and Restore” 

default 50% value.  Some users will change this to 0% and thereby have the 

automatic scheduled backups always perform a Full backup, instead of an 

Incremental backup.  

DOUBLE IMAGE 7.0 LIMITATIONS 

Copy system image 

 Double Image 7.0 does not provide for snapshot backups. By 2nd quarter 

2015 ‘Double Image-O’ will be released to provide snapshot image 

backups to local drives, external drives and network locations. 

  

Boot from repair disc  Double Image installation does not currently provide a system repair disc 

for boot recovery. 

https://hostinterface.com/WebHelp/Right_Mouse_Button_in_Backup,_Restore_Trees.htm
https://msdn.microsoft.com/en-us/library/windows/desktop/dd408121(v=vs.85).aspx
https://msdn.microsoft.com/en-us/library/windows/desktop/dd408121(v=vs.85).aspx
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WINDOWS BACKUP AND RESTORE LIMITATIONS 

Backup from sub-folders or 

files 

 does not support backing up to a sub folder of a volume. The source must 

be a drive letter or an UNC network path like: \\<your machine 

name>\D$\backups\   

File Systems 

 Backup and Restore can only make a system image of disks with NTFS file 

system and using the file format VHD (virtual hard disk).  

 If the system image is to be saved on a USB flash drive, it must be 

formatted with NTFS file system. 

System Image Backup 

 Windows 7 allows performing a full system image backup to a network 

location, however, subsequent incremental system image backups cannot 

be performed to a network; 

 Windows 8 no longer provides ‘previous versions’ restore points and has 

replaced that feature with File History. 

 All image based backups to the network must be full backups; although 

Full system image backups to local or removable storage can be 

incremental. 

System Backup  Full system backup to a network requires Windows 7 Professional or above 

editions. 

Destination 

 Windows 7 file backup to a network share is available only with Windows 7 

Professional, Enterprise and Ultimate editions. 

 The destination drive may not be a mapped network drive. 

  

https://hostinterface.com/WebHelp/UNC_Definition.htm
http://en.wikipedia.org/wiki/NTFS
https://support.microsoft.com/en-us/help/17127/windows-back-up-restore
http://en.wikipedia.org/wiki/Features_new_to_Windows_8#File_History
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PLANNING AND STRATEGIES 

TOOLS 

This topic makes reference to ideas and tools used for doing backup and recovery on Windows operating 

systems starting with Windows Vista and higher; although the principles can apply to other systems. 

BACKUP 

To ensure that you can overcome losing a system hard drive entirely, you should have at minimum these basic 

backups: 

CREATE A WINDOWS ‘SYSTEM REPAIR DISC’ 

You can get by with a number of backup schemes to restore a file, a group of files, the registry and …, but all 

looks grim when the Windows system disk will not boot on startup. You need a recovery disc to access the 

System recovery option discussed below. The original Windows installation disc can serve as a start, but it 

might be better to have a recently created System Repair disc that is more current. 

Windows Backup and Restore provides for creating a ‘System Repair Disc’ to DVD.  Once created, the DVD disc 

can then be used to boot up Windows from the ‘System Repair Disc’ when nothing else works to boot from the 

system hard drive.  

How to create a System Repair Disc 

 Open Backup and Restore by clicking the Start button, clicking Control Panel, clicking 

System and Maintenance, and then clicking Backup and Restore.  

 In the left pane, click Create a system repair disc, and then follow the steps. If you're 

prompted for an administrator password or confirmation, type the password or provide 

confirmation. 

 a ‘System Repair Disc’ on hand, with a label written on it that defines it being for your particular machine 

and operating system. 

 Create Restore Points 

 A ‘system image’ backups:  Backups of recent restore points to another non-system disk. 

 Use Double Image 7.0 to create tailored file backup and restore sessions using command lines with files 

written in native Windows Explorer format. Double Image 7.0 has a wide selection of options that can be 

applied via the user interface, command lines or scripts. 

https://hostinterface.com/WebHelp/Command_Line_Options_Defined.htm
https://hostinterface.com/WebHelp/Options_Selection.htm
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CREATE RESTORE POINTS REGULARLY 

First note that a Restore Point is not the same as a System Image backup, although a System Image backup will 

produce a Restore point of the source volume prior to beginning its backup session. 

Here we are referring to Restore Points. Before you can recover using the System Restore Option, you must 

previously have had your system create one or more restore points.  A restore point is a representation of a 

stored state of your computer's system files. You can use a restore point to restore your computer's system 

files to an earlier point in time. You can manually create a restore point at any time. 

Restore points can be created by the following methods: 

 Weekly and a automatically by the system’s ‘System Restore’ feature. 

 When ‘System Restore’ detects the beginning of a change to your computer, mainly when 

you run an install package to install a program or a driver and sometimes when Windows 

updates are applied. 

 Manually create a Restore point 

 Open System by clicking the Start button , right-clicking Computer, and then clicking 

Properties.  

 In the left pane, click System protection.  If you're prompted for an administrator password 

or confirmation, type the password or provide confirmation. 

 Click the System Protection tab, and then click Create. 

 In the System Protection dialog box, type a description, and then click Create. 

 

 

CREATE SYSTEM IMAGE BACKUPS 

System image backups stored on hard disks can also be used for System Restore, just like the restore points 

created by system protection. For more information about system images, see What is a system image?  

DOUBLE IMAGE BACKUP SOFTWARE 

So far the topic has been about backup and restore relating to recovery if the Windows system can’t boot to a 

Windows state or the hard drive fails.  Other types of recovery needs can require only a partial restore.  The 

Windows Backup And Restore automatically runs either daily or weekly with a weekly default on Sunday 

evening. Well, it’s like kids needing only to see a doctor on a Saturday night--things can go wrong at the 

wrong time. A full restore can wipe out work that has been done and not backed up yet by Windows Backup 

And Restore. 

https://support.microsoft.com/en-us/help/4027538/windows-create-a-system-restore-point
http://windows.microsoft.com/en-US/windows7/What-is-a-system-image
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In the case of a partial restore, it might be good to have another solution on hand. Double Image is good for 

data backup, data restore and for restoring the registry, or a part of. 

Double Image has wide selection of backup and restore options. You can backup selected drives, folders and 

files as well as the Windows active registry; including remote registry backup and restores. The registry can be 

restored to an active machine. You can do network backups of other machines and backup your machine to 

other networked computer drives. For details, see Double Image 7.0 online document. 

RECOVERY 

SYSTEM RECOVERY FROM A WINDOWS ‘SYSTEM REPAIR DISC’ 

The System Recovery Options menu contains several tools, such as Startup Repair, that can help you recover 

Windows from a serious error. 

STARTUP REPAIR 

Just after power-on and the system is in the boot phase, press {F8} function key. This invokes Windows 

Repair from the hard drive.  If you learn that the Windows Repair is inaccessible from the system hard 

disk, then revert to using either your Windows Installation Disc (the one with your license) or a System 

Repair Disc you created for the machine with the problem. 

Try this first to automatically fix problems that prevent Windows from starting.  This is of no value if you 

have a system hard drive failure or system files are beyond repair. Startup Repair can only fix certain 

problems, such as missing or damaged system files. It can't fix hardware failures, such as a failing hard 

disk or incompatible memory, nor does it protect against virus attacks.  

Startup Repair isn't designed to fix Windows installation problems, nor is it a backup tool, so it can't help 

you recover personal files, such as photos or documents. To help protect your computer, back up your 

system and files regularly. 

To open the System Recovery Options menu on your computer 

1. Remove all floppy disks, CDs, and DVDs from your computer, and then restart your 

computer using the computer's power button.  

2. Do one of the following:  

a. If your computer has a single operating system installed, press and hold the F8 key as 

your computer restarts. You need to press F8 before the Windows logo appears. If the 

Windows logo appears, you need to try again by waiting until the Windows logon 

prompt appears, and then shutting down and restarting your computer. 

https://hostinterface.com/WebHelp/


BACKUP AND RESTORE 

 

 

Comparisons and Planning:  ‘Windows Backup and Restore’ including ‘Double Image 7.0’   16 

b. If your computer has more than one operating system, use the arrow keys to highlight 

the operating system you want to repair, and then press and hold F8. 

1. On the Advanced Boot Options screen, use the arrow keys to highlight Repair your 

computer, and then press Enter. (If Repair your computer isn't listed as an option, then 

your computer doesn't include preinstalled recovery options, or your network 

administrator has turned them off.) 

2. Select a keyboard layout, and then click Next. 

3. On the System Recovery Options menu, click a tool to open it. 

To open the System Recovery Options menu using the Windows 7 installation disc or a USB 
flash drive, or a system repair disc 

If your computer's system is severely damaged and you can't access the System Recovery 

Options menu on your computer, you can access it using the Windows 7 installation disc or a 

USB flash drive, or using a system repair disc if you created one earlier. 

To use this method, you need to restart (boot) your computer using the disc or USB flash drive. 

1. Insert a system repair disc or the Windows 7 installation disc; then shut down your 

computer in order to boot from the disc. (the bios boot up settings need to allow boot 

from the CD, DVD or USB drive). 

2. Restart your computer using the computer's power button.  

3. When prompted, press any key, and then follow the instructions that appear. 

4. On the Install Windows page, or on the System Recovery Options page, choose your 

language and other preferences, and then click Next. 

a. If neither the Install Windows page nor the System Recovery Options page appear, 

and you're not asked to press any key, you might need to change some system 

settings. To learn how to do this, see Windows 7 installation: Create or Use a system 

repair disc (USB flash drive). 

5. If you are using the Windows installation disc or USB flash drive, click Repair your 

computer. 

6. Select the Windows installation you want to repair, and then click Next. 

7. On the System Recovery Options menu, click a tool to open it. 

 

http://windows.microsoft.com/en-US/windows7/Start-your-computer-from-a-Windows-7-installation-disc-or-USB-flash-drive
http://windows.microsoft.com/en-US/windows7/Start-your-computer-from-a-Windows-7-installation-disc-or-USB-flash-drive
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SYSTEM RESTORE 

Restore Windows from an existing ‘restore point’ on your system hard drive. This is valuable if your hard 

drive is not physically destroyed. These are the same restore points you may have seen when viewing 

Properties of a hard drive or folder, where the ‘Previous Versions’ tab displays all existing restore points by 

date and time. Normally you will choose a restore point with the most recent timestamp. You may lose 

recent program changes, but not your data. 

SYSTEM IMAGE RECOVERY 

You need to have created a system image beforehand to use this option. A system image is a personalized 

backup of the partition that contains Windows, programs and user data like documents, pictures, and 

music. 

Choose this option if System Restore cannot fix the problem and you have a relatively recent system 

image.  You will likely lose some data created or changed since the image was created, unless you have 

that data on a separate drive or flash drive; or have another backup that Double Image 7.0 created. 

WINDOWS MEMORY DIAGNOSTIC 

Check your computer for memory hardware errors. Running the Memory Diagnostics Tool won’t do any 

damage and might uncover the reason your PC hangs, freezes, or crashes. 

COMMAND PROMPT 

Advanced users can use Command Prompt to perform recovery-related operations and also run other 

command line tools for diagnosing and troubleshooting problems.  

 

FILE RECOVERY USING DOUBLE IMAGE 

For partial restores, consider this: Double Image has a feature that can quickly provide you colorful detailed 

report log showing which files have been changed, added or deleted since the last backup. If you already have 

some idea where a problem area is on your system, then from this report you may be able to decide just which 

files should be recovered. 

SCENARIOS 

PROBLEM-1 - You have a full system image backup but it’s 5 days old and you have done a lot of work in the 

last 5 days and you have just learned that most if not all of the accounting files need to be reloaded due to 

http://windows.microsoft.com/en-US/windows7/What-is-a-system-image
https://www.hostinterface.com/
https://technet.microsoft.com/en-us/library/ff700221.aspx
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what appears to be an operator accident. The good news is you have run scheduled Double Image backup 

sessions every day. 

SOLUTION-1 - Open the Double Image backup profile that is used to backup up your entire system. Click the 

Restore button,  de-select the 2 backup drives because not all needs to be recovered, then only check the 

‘c:\user\Joes name\accounting\’ folder, and click ‘Restore’.  Double Image does a restore based on 

[date | time | file size | name | file attributes].  When both the backup and the restore target files are the same a 

file copy is not necessary and the next file is compared; then when they are different the files are restored. This 

recovery is quite fast. 

          

PROBLEM-2 - You recently removed an application using Windows Programs and Features (add remove 

programs) only to discover you actually need this program on your machine.  To add some disappointment, 

the install disc cannot be found. 

Let’s think about the problem, again: 

 

 Why not use ‘Previous Versions’ and restore only the program?  Installed programs will usually reside 

in C:\Program Files (x86) or C:\Program Files together with some settings in the registry 

and possibly a system file or two in C:\Windows\System32.  Good idea? …probably not.  Windows 

Restore points will not recover the registry while you have your machine live, unless you do a full 

system image restore.  

 Also, we don’t want to restore everything because only the program was removed and it takes a long 

time; furthermore,  lots of work was done today to the accounting system and to the updated Outlook 

(.PST) file holding emails, appointments and contacts which has not been backed up since last night-- 

don’t want to lose that activity. 
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SOLUTION-2 - open the Double Image backup profile that is used to backup up your entire system. 

How ‘Backup Mode’ looks (in the example shown below): 
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How we want the Restore Mode to look (in the example shown below): 

  

How we modified the Double Image restore settings 

1. click the Restore button 

2. un-checked the drives 

3. checked C:\Program Files (x86) 

4. checked C:\Windows\System32 

5. in the options area, choose 

6. under the Copy options choose ‘Registry Options’->‘Restore the registry files on a computer if that 

computer has its Windows system folder restored’ 

7. to view only what we want to restore:  from the menu->View->Show Only Checked Items 

8. click restore. 
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9. reboot, any time the registry is restored 

          

PROBLEM-3 - Some files were written to my hard drive by accident and I don’t know which files were written 

over  and which files should not be there. 

SOLUTION-3 - Find them, using Double Image.  Open the Double Image backup profile that is used to backup 

up your entire system. From the menu, click Tools->Report->Just show differences.  Double Image runs 

through the entire backup, comparing the source to the most recent backup files and when a difference is 

discovered the a log entry is created showing the date, time, source path, target path.  Now that you have 

identified which files should not be on the drive you can remove them; while those that were written over by 

accident can be selectively restored. We will also consider selecting the option to ‘Never over-write newer 

files with older files’. 
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OTHER REFERENCES 

Windows® 7 Inside Out by Ed Bott, Carl Siechert, and Craig Stinson "Chapter 11: Backup and Restore" 

 

 

 

http://download.microsoft.com/download/A/7/0/A704218A-B47C-4F2E-A318-22288DA1B801/626652_Win7InsideOut_Chapter_11.pdf
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